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MARK YOUR CALENDAR 

 7 p.m. 
Meetings 2nd Thursday of each month 

www.cbwug.com 

CADDO-BOSSIER  
WINDOWS  

USER GROUP 
 

Shreveport – Bossier City 
Louisiana 

Group Listens to Richard Conradi’s Presentation 

          Member, Richard Conradi, 
with After Hours Computer Spe-
cialist, LLC was our guest 
speaker in May. The meeting 
started with a very active ques-
tion and answer session that 
ranged from trying to locate a 
lost file, problems with using the 
Internet, not being able to get 
emails that you know have been 
sent to you, having to wait a long 
time for one popular Internet 
browser to load, and other prob-
lems members were experienc-

ing.  After the question and an-
swer session Richard gave a very 
enlightening program on the 
popular online networking site, 
Facebook. He showed how to set 
up a Facebook account, all the 
things you can do when you are a 
member, how to add pictures and 
add friends and much more. Time 
ran out before he was able to 
even touch on twitter, and other 
online networking sites. Maybe 
we can get him to come back and 
show us more. 

Please join us in June and learn 
more about ways to improve 
your computing. There will also 

be answers to questions that have 
been asked at previous meetings.  
Visitors welcome. 

May Meeting 
By Glenda Conradi  

We want to thank Richard Conradi for 
presenting the May program on how to 
utilize Facebook, a very popular online 
networking site. 

June Program 

By Glenda Conradi  



 

   

                   
 THE WINDOW                                                 June 2009                                                                          Page 2 

THE WINDOW 
 

Published by  
Caddo-Bossier Windows User Group 

Member of APCUG 
 

Editor  
Glenda Conradi  (glenda@conradi.com) 
 
                        Co-Editor  
Jay Graff            (jay@jayGraff.com)  
 
Submit articles for newsletter, in RTF 
file format, by last day of month to 
glenda@conradi.com.  
 
The opinions expressed in the articles in 
this newsletter are not necessarily those 
of the editors or publisher. Mention of 
products by their trade name does not in 
any way constitute endorsement by the 
editor or publis her. 
 
The Caddo-Bossier Windows  User 
Group is a tax exempt, non-profit club. 
  
Membership Dues. 
Full: $12.00 a year 
Spouse: $6.00 a year 
Student: $6.00 a year.  

Podnuh’s Bar-B-Q 1146 Shreve-
port-Barksdale Hwy for letting our 
group hold our monthly meetings in a 
private dining room in  their restau-
rant. 
 
BancorpSouth on Youree Drive for 
providing us with a checking account 
at no charge. 

Shortcut For Deleting Line of Text 

C-B WUG’s Web Address 
www.cbwug.com      We had a nearly full house at this months meeting.  It is very good to 

see a good crowd for our meetings.  Steve Burroughs was a quest this 
evening; he was accompanied by Kyle Widener.  We have known Steve 
since the days of the Commodore Users Group.  Larry and Nyla Farley 
joined the group this evening.  Welcome Larry and Nyla. Glenda made 
the usual announcements and offered some ink cartridges that were do-
nated, to anyone who had a printer that could use them.  They were 
some HP and Brother ink cartridges.  The questions for this month were 
the loss of a file by Larry Farley.  He said he saved the file but could not 
locate it on his computer with numerous searches.  Richard suggested it 
look in the recent documents on the bottom of the File menu.  Carole 
White had a problem after installing a network card.  The computer asks 
for a password and she did not know how to resolve the issued.  It was 
suggested she use the F8 key on boot up and see if she could gain access 
and reset the password in Safe Mode. I read a problem from Billy 
Walker about receiving mail using Windows Mail and AT&T DSL.  
Richard stated that there is a problem and it would take some research to 
figure out what is happening.  Clyde Santifer said his Firefox was slow 
to load and was looking for ideas to speed it up.  He got several.  Rich-
ard Conradi, of After Hours Computer Specialists, presented the pro-
gram this evening on social networking sites and how to use them.  
Most of the evening was taken up by Richard showing the ins and outs 
of Face Book.  The door prizes for this month were a pack of 50 DVD 
plus Rs won by Fred Kocher and a can of air won by Joe Blase.  Con-
gratulations to our winners. 
Our next meeting will be June 11, 2009.  
 
     Bernie Conradi, President Caddo-Bossier Windows Users Group.  

Club Officers  
President            Bernie Conradi  
          (bernie@conradi.com) 
 
Vice-President     Wayne Ebert 
          (wdebert@suddenlink.net) 
 
Secretary               Glenda Conradi 
          (glenda@conradi.com) 
 
Treasurer               Charlie Byrd
          (cbyrd22@suddenlink.net) 

 
   

Board Members at Large 
(Open) 
 

~Thank You~ 
   We want to express our gratitude to:  

~A QUICK TIP~ 

 There is a quick shortcut for deleting 
a whole line of text you've just fin-
ished, because it doesn't look right, or 
you want to say something else. 
Instead of continuously pressing the 
backspace key, put your cursor at the 

beginning of the line you want to de-
lete and press Shift+End. Then press 
delete or backspace to delete the 
whole sentence. Because your cursor 
is at the beginning of the line, you 
can just start typing again. 

Caddo-Bossier Windows Users Group May Meeting  

President’s Page 



Disable Desktop Cleanup 

Door Prizes Winners for April 2009 Meeting 
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GETTING STARTED TIPS 

The May door prizes were won by Joe Blase, a can of compressed air & 
Fred Kocher, a pack of 50 DVD plus Rs. All Caddo-Bossier Windows 
User Group club members in attendance are eligible to win door prizes at 
the monthly meetings.   

Joe Blasé and Fred Kocher and  

Let’s face it; I am a big fan of Win-
dows Vista. Sometimes it seems 
hard to get used to some of the 
newer features, but overall, I would 
give it a pretty high rating. One of 
those things I had to get used to (but 
now cannot do without) is the Win-
dows Sidebar. I have not put a lot of 
things there, but the ones there have 
proven to be most useful. I have a 
digital clock as well as the usage 
gauges. The one I used the most is a 
thing called the App Launcher. 
Mine contained about 4 or 5 of my 
most use apps. It seemed like I was 
constantly going to it Recently 
though, it seemed to change and ei-
ther slow down or quit working al-
together. That is when I decided to 
fire it and go looking for a new one. 
At first I went looking for a Yahoo 
Widget. I have one of those too in 
the same place. That one is a scroll-
ing text box that I use for a constant 
reminder. Anyway, I could not find 
a suitable Widget, but in my search, 
I stumbled across a program called 
RocketDock. It is a free program 
that puts one or more icons in a 
panel, much like App Launcher did. 
The one and probably only thing I 
don’t like about it is that you only 
have the choice of 4 locations, top, 
bottom, left or right on your desk-
top. But other than that minor in-
convenience, you have a lot of con-
trol over the way it works. Since I 
had that limited option, I decided to 
put mine at the top. The very first 
thing I did was to get rid of most of 
the icons already present. At first I 
was slightly taken aback. When you 
hover over one of the icons, it gets 
very large until you click on it and 
move away. I made mine much 
smaller than the original size, plus I 
lowered the opacity. I put the same 
icons I had in the App Launcher in 
it, plus a couple others. Adding 
shortcuts could not be easier. All 
you do is drag it from where it is 
and let go of your mouse. It auto-
matically appears in there.  There 
are still features that I have not ex-

by Jay Graff 

plored, but one I like is the one that 
it will mark any application in there 
with a little black arrow indicating 
that the program is still open. I tried 
it with Skype and it worked fine. 
Seems like I am constantly forget-
ting that I had it open, so this will 
serve as a good reminder. Another 
thing that you should be mindful of 
is that at the right end of the dock, 
there is a separator and to the right 
of that is your recycle bin icon.  Nor-
mally I would not keep this item 
here, and if you right click on it, or 
even  click, it, you will either open it 
or have the option to do other things, 
depending on how you did it. At first 
I thought it could not be removed, 
but after further checking, discov-
ered that you could it you want to. I 
opted to keep it for the time being.  
If this seems like something you 
might be interested in, you can 
check it out at: 
www.rocketdock.com 
Enjoy  
  

ROCKETDOCK 

If you would like to disable 
Desktop Cleanup you can do so 
by following  these steps. 
     Right click on the desktop and 
choose “Properties”. A Display 
Properties box will come up. 
Click on the Desktop tab which 
is the second tab on the left, then 
click on the “Customize Desk-
top” button. This will bring up 
the Desktop Items box. Click on 
the first tab, which is the General 
tab. 
     Under the “General” tab you'll 
see Desktop Cleanup towards the 
bottom of the window. Just un-
check the “Run Desktop Cleanup 
Wizard every 60 days” selection 
and click OK. You can follow 
the same steps, but click on 
Clean Desktop Now, when you 
are ready to clean the desk top. 



 DID YOU KNOW? 
 If you delete something you have 
just typed, and decide you want it 
back, you can press Ctrl-Y. This key 
combination will bring back the 
mistake you thought you made if 
you do it right after you have de-
leted it. 

Bing 
http://www.bing.com/  
(Bing is Microsoft’s answer to Google. It 
is a live search engine that finds and or-
ganizes the answers you need so you can 
make faster, more informed decisions.) 
 
SmartPlanet 
http://www.smartplanet.com 
(CBS Interactive has unveiled a new web-
site dedicated to people who realize the 
need to make our world a better place to 
live, for all of us, and for generations to 
come.)  
 
ZDNet Newsletters 
http://nl.zdnet.com/acct_mgmt.sc?
brand=zdnet&urs_auth=1 
(Sign up for ZDNet newsletters, product 
watch, downloads, tech updates and 
more.) 
 
Ehow 
http://www.ehow.com/guide_12-home-
garden.html  
(How to do just about everything. Tips on 
home improvement, house keeping, pests 
control, weeds , gardening, arts and en-
tertainment fashion, electronics, educa-
tion, computers and many other subjects. 
The list goes on and on.) 
 
Bing Maps  
http://www.bing.com/maps/ 
(Explore the Earth with interactive maps, 
directions and traffic, satellite and aerial 
images, bird’s eye view, 3D maps and 3D 
cities. Search addresses, yellow pages, 
white pages and more. (Bing maps was 
previously Live Search Maps, Windows 
Live Maps and Windows Live Local)) 

                   

~Web Sites~ E-mail Woes 

Have you noticed that Outlook Ex-
press or Windows Mail feels slug-
gish when starting, or when chang-
ing folders.  Performance issues 
such as these usually mean that 
some minor corruption has occurred 
to the message store folder. Com-
pacting all folders in Outlook Ex-
press usually repairs mild corrup-
tion and returns mail to normal. 
Don't confuse compacting a folder 
with compressing a folder.  
 
Mail messages are stored on the 
hard drive in a message store folder. 
Outlook Express stores them in .
DBX files. Windows Mail now 
stores them in WindowsMail.
MSMessageStore file. When a mes-
sage is deleted or moved to a differ-
ent folder, the space that message 
occupied remains in use. The mes-
sages are just marked as deleted or 
moved, thus these message folders 
can grow to an enormous size. To 
solve the problem of store folders 
growing out of control, one must 
compact mail store folders periodi-
cally. In Outlook Express choose 
File > Folders > Compact All Fold-
ers, to free up the space previously 
occupied by deleted or moved mes-
sages. 
 
 Vista and Windows Mail does not 
have the Compact All Folders op-
tion. Microsoft decided their users 
are not smart enough to handle that 
task, so every 100 times you close 
Windows Mail a window pops up, 
"Windows Mail can compact the 
message store. This can take a few 
minutes." with the options of "OK 
or Cancel". Microsoft made it sim-
ple for the simpleton. What if you 
want to compact your mail store 
folders before the magic 100th time 
Windows Mail closes? It takes a 
few clicks, but there is a way to 
compact messages right away. Se-

lect Tools from the Options menu, 
click the Advanced tab, and click 
the Maintenance button. Find the 
line that says Compact the database 
on shutdown every 100 runs. With 
that option checked, change it from 
100 to 1, and click OK, OK. When 
you shut down Windows Mail, it 
will offer to compact messages; 
click OK. To stop the offer to com-
pact messages every time Windows 
Mail closes, go back into the Main-
tenance dialog and set the interval 
back to 100 or whatever interval 
you prefer. 
 
Compacting your folders periodi-
cally is a must to keep your mail 
functioning flawlessly. And remem-
ber, when you delete, or move mes-
sages, the space they had used re-
mains until you compact the mes-
sage store folder. Do not archive 
mail in default folders. They will 
eventually become corrupt and you 
may lose mail. Create your own 
user defined folders for storing 
mail. Empty Deleted Items folder 
regularly. Keep user created folders 
under 100MB, and Default folders 
as empty as possible. 
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By Bob Franklin 

 In Remembrance Of  

We offer our condolences to David’s 
wife Francine, and their family. David 
was a dear friend to many of us and 
contributed so much to our group. 
David will be deeply missed.  

          David Minor Huckabee 


